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Intro to |IES8

An Introduction to the
Microsoft Web Browser

Internet Explorer 8 is Microsoft’s internet browser. [t’s most
commonly referred to as IE8, but the most current release of the
browser is IE9, which was released on March 14th, 2011. For
the purposes of this guide, we will be discussing IES8.

IE8 provides many improved basic and safety features over
previous versions of the browser, including InPrivate and tabbed
browsing.
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Introduction to the Browser

Your Internet browser may be something new to you, but fear

not, it won’t stay that way for long! By poking around a bit,
you'll find all sorts of little treasures “hidden” in the menus and
toolbars of Internet Explorer that will
great World Wide Web.
along the way.

’ Note: If you are given a web

address with no www (ie — ‘cisco.netacad.net’) you do not need to add the ‘www’ in front of this
address. By doing so it may lead you to an invalid website address.

help you navigate the

Hopefully this manual will help you

Not all websites require ‘www’ in front of the website address.

Browser Search Field - Type in a search topic,
the browser will open in the current tab to
complete the search for you

Address Field - Where you type the URL (the inter-
net address), the page you requested will open in
the current tab (i.e. www.theweathernetwork.com)

/2 Google - Windows Internet Explorer

e Bl

Qv googleca’

- |+ | % W& Live Search P -

File Edit View Favorites Tools Help

These are your
toolbars. Where
B =

{ % @@ v Pagev Safetyv Tooks+ @+ ”4_ )’OU’” find all your
Web Images Videos Maps Mews Books Gmail more v

iGoogle | Search settings | Sign in

¢ Favorites | 55 @ Keewatin Academy of Inf... &) Sug
*4 Google

ted Sites v @] Web Slice Gallery »

A

menus

GO O 816

Advanced search
Language tools

Google Search | I'm Feeling Lucky

3 Make Google my homepage

Goagle ca offered in francais

Advertising Programs  Business Solutions  About Google  Ga % Google com

© 2011 - Privacy

Status Bar - displays
status of webpage or
link when hovered over

Google Search Field - Type in a search
topic, Google will do the search for you
(i.e. ‘Saskatoon local news’)

Change background image

\
Done A

1y, March 30, 2011
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Introduction to the Browser

Now that you've had a quick introduction to the parts of a
browser, let’s see how much you’ve learned!

(Try it first without peeking!)

- Type in a search topic, the
browser will open in the current tab to complete
the search for you

- Where you type the URL (the

internet address), the page you requested will open
in the current tab

/2 Google - Windows Intemnet Explorer
% - B

R google.cal

File Edit View Favorites Tools Help
¢ Favorites | 5 € Keewatin Academy of Inf...
*4 Google

- |+ | % W& Live Search
] Suggested Sites v @] Web Slice Gallery v

These are your

<
<«

Web Images Videos Maps Mews Books Gmail mi

ore ¥

L v B v = & v Pager Sofetyv Tools+ @~ »‘ Where )’OU’” find

iGoogle | Search settings | Sign in

all your menus

Google

Canada

| Advanced search
Language tools

Google Search | I'm Feeling Lucky

#} Make Google my homepage
Goagle ca offered in francais
Advertising Programs  Business Solutions

About Google  Ga % Google com

2011 - Privacy
- displays
status of webpage or

link when hovered over

- Type in a
search topic, Google will do the
search for you

Change background image

Done A

&4 TweetDeck 4% Danielle me...
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Toolbars

Intro to |IES8

Menu bar — The menu bar is where one would access such items as “File, Edit, Favorites, View,

Tools, and Help”

Status bar — The status bar displays the status of the web page, whether it is loading or if it is a
protected page, information about the internet address when hovering over a link, or if it a page
accessed on the internet or loaded from an HTML file on the local drive, etc.

Command bar — The command bar, located on the far right of the browser, is

Favorites bar — The favorites bar saves and stores webpages they’ve marked as a “favorite” so

that they may access it at a later date

NOTE: these items may not appear on all browsers due to layout changes. To access these items at

any time, first press the ‘alt’ key on your keyboard to make them visible.

Menu Bar

> Keewatin Academy of Information Technology - Window= (nternet Explorer

File Edit View Favorites

Tools

Help

If any of your toolbars go missing, either click on “View” on your Menu Bar, or
click on “Tools” on your Command Bar, and then “Toolbars” from the drop down
menu. Another menu will appear. Select the missing toolbar.

Command Bar

7"\? Favorites | 3':5 £ | Suggested Sites v @] Web Slice Gallery

;ﬁ Keewatin Academy of Information TecAhology

Favorites Bar

PEPPTELOLL%

LF
P
]

ITE: PC Hardware & Software

Teacher: Nick Daigneault
Teacher; Jayshree Redwood

Status Bar

> http:/fwww.kait.ca/course/view.phpTid=3
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File

Under the File options, you can access other features such as
New Tab, Save, Print, Properties, and Exit.

Edit

When you've selected text on the webpage, you can go to Edit
to find the Cut, Copy, Paste, and Select All options.

View

View allows you to not only add or take away toolbars such as
the Menu, Favourite, and Command Bar, but also allows you to
view the History, Favorites and Feeds bar on the side.

Under View, you may also change some settings such as the text
size, zoom and styling of the webbrowser.

Have you ever Ilooked up and found that
everything on your browser is either really huge
or really small2 Well, don’t panic! This is an
easy fix. Click on View > Zoom > and select
100%.

Favorites

Favorites is where you can bookmark your favourite websites for
later reference. To add a website, click on Favorites > Add to

Favorites.

There is also a Favorites Bar on the toolbars, which can be
viewed by clicking on View > Toolbars > and selecting Favorites
Bar. By adding a website to the Favorites Bar instead of simply
marking it as a Favourite, you instantly make it more accessible.

/2 Keewatin Academy of Information Technology - Windows Internet Explorer

File Edit View Favorites Tools Help

/'33 Favorites | {w‘;gﬁ Keewatin Academy of Inf... | @ | Suggested Sites v @ | Web Slice Galler
Keewatin Academy of Information Technolog
http://kait.ca/

Favorites Bar
@ Keewatin Academny of Information Technology|
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Tools

IE 8 offers a lot of extra security options accessible in the Tools
option in the Command Bar. These options include Delete
Browsing History, InPrivate Browsing, InPrivate Filtering, Pop-up
Blocker, SmartScreen Filter, etc. (all of which will be looked at

more closely later in this manvual).

The Internet Options settings can also be accessed via the Tools
options in the Menu Bar. Here, you can set options such as your
Homepage, change how tabs are viewed, the overall appearance
of your browser (including colour and fonts), set security and
privacy settings, set up your internet connection if you have dial
-up, make IE your default browser, and many other settings.

Another important feature of the Internet Options is the Content
Tab. Here you can turn-on and turn-off autocomplete for web
addresses, forms, and more importantly passwords. This is useful
for people who use social networking and online banking as to
not leave confidential information such as logins stored on a

computer.

|72 Keewatin Academy of Information Technology - Windows Intemet Explorer

43| x QR Live Search -

ral

S .- [ =

@®

file Edit View Favorites Tooks Help

o Favorites | o &) Suggested SPR~ ] Web Slice Gallery ~
% v B - [ & v Pagev Sefetyv Tooks~ @~

JC Keewatin Academy of Information TecNpology

> il

l}n‘lﬂmﬂ Oﬂnns 4

General |Security I Privacy | Content I Connections I Programs | Advanced | ||

Home page
I/? To creste home page tabs, type each address on its own line.
a
S e — %

B Main Menu
& Site news

h About Us
ntern Resources

ourse Information
Contact Us

(® CISCO Net Academy Login

M Login
I

Username:

[ Use current ][ Use default ][ Use blank ] St

Browsing history ———

Lost

";I_ y Delete temporary files, history, cookies, saved passwords,
)

(© KaIT Email and web form information.
[@ Software Skills Lecture M Calendar =
ggg:“‘;{"f ; [ Delete browsing history on exit < March 2011 >
A D1 Lecture

[® CCNA D2 Lecture Officq = Sun Mon Tue Wed Thu Fri Sat

Delete... I [ Settings ] 1 2 3 a3

& 7 8 s 10 i1 12

H Online Users B Search % 1314 15 16 17 o1s 19
(last 5 minutes) 20 21 22 24 25 26

P
@] Change search defaults. 27 28 23 30 3
IT Sq }"

Tabs H ing Events =

There are no upcoming events

Change how webpages are displayed in Settings
= e Go to calendar...
ITE:
Appearance — -
Colors ] [ Languages ][ Fonts ] [ Accessibility ] =
e Mode: On v ®i0% -

']

o (o) [ ]
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Help

If and when you're

error on the page,

at a loss for

or you need a

what's
little bit

gone wrong,

browser, there is always the Help option.

Help

Fil

=

e Edit View Favorites

/™ Keewatin Academy of Information Technology - Windows Internet Explorer

o0 Help

there’s
more help with

an
the

T-::f' Favorites | '{:‘5 .ﬁ' Keewatin Acad

level by prepa

Available Courses

|.ﬁ' Keewatin Academy of Information

Version: 8.0.6001,19019

Cipher Strength: 256-bit

Product ID: 01402-997-7332132-00029
Update Versions: 0

s

In the Help menu,

possible under the law.

£12009 Microsoft Corparation

{e Internet Explorer8

Warning: This computer program is protected by copyright law and
l international treaties. Unauthorized reproduction or distribution of
this program, or any portion of it, may result in severe civil and
criminal penalties, and will be prosecuted to the maximum extent

Internet Explorer Help

What's Mew in Internet Explorer 8

Online Support

About Internet Explorer

you can also find a

link to Microsoft

About Internet Explorer

Internet

Explorer’s Online Support as well as basic information about the

current installation

of your browser.
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Tabbed Browsing

The first version of Internet Explorer to include the feature
called Tabbed Browsing was IE7 back in 2006, so this feature
has been around for a while. Tabbed Browsing allows for
multiple websites to be accessible within a single browser
window. This potentially reduces the number of windows and
applications open on the Windows Task Bar on the bottom of
your screen.

You can also open links and other windows within tabs in the
Internet Explorer browser window. If you have multiple tabs
open, you can use Quick Tabs to easily switch to other tabs.
Quick Tabs provides a thumbnail view of all your open tabs
making it easier to navigate between multiple tabs.

Opened Tabs in IE8

™ Keewatin Academy of Information Technology - Windows Internet Explorer

A

ile Edit View Favorites Tools Help

Ly

i Favorites | ql3 @@ Suggested Sites » @] Web Slice Gallery =

- [53% | x 82 tieseorch EE

8- m Keewatin Academy of L. X _\" MSMN Canada - The home ... -'l Google

olsen] @ ket Potected iode On av mwx -

To close a tab, you simply click on the tab you wish to

close and click the “x” that appears on the tab. If you

accidentally close the wrong tab:

1. Open a new tab

2. On the new tab page, under Reopen closed tabs, find and
click the address for the webpage that you want to open.
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If there are a group of tabs that you would like to save, click
the Favorites button, then click the arrow next to the Add to
Favorites button, then click the Add Current Tabs to Favorites.

Once you've done that, give the tab a group name, then click
Add.

Favorites

|/ Keewatin Academy of Information Technology - Wir-Zuws Interet Explorer
9 [

Ele Edt View Favortes “Tools Help

<5399 | x | tvesearcs =

% Favortes | . ] Suggested Sites v ] Web Sice Galery v

TSt dIT ccorerator. -~

Open a web service with text that you've copied from a webpage.
Add Tabs to Favorites

Add Tabs to Favorites

> 2/\{ Type a folder name for the open tabs you want to add to your
“ favorites. To access your favortes, vist the Favorites Center.

Folder Name: =]

G Keewatin Academy of Information Technology

Create in: 5.7 Favorites - ]

Ke

l@asinA:ﬂde y 8
=] oo s 2|
% ) ¥ 5 Cancel
pr
=]
= level by preparing them for the
® L and InPr
©
©
Available Courses
©
© = e ]
© Office 2003/Software kil THmmg = e
This course covers the Microsoft MOS Objectives in
eschars St each of the Office applications. It will also cover any FER- B o4
M Online Users 2 Teacher: Nick Daigneault additional software as spedified. 19 34 15 16 17 18 19
(st 5 minutes) 2 2 2[m]a = 2
Bk =]
27 2 2 30
IT Security
This course compliments the resources that were
distributed with the IT Security Training Packsge given -
to schools across Saskatchewan. - G
There are no upcoming events
Goto calendar...
ITE: PC Hardw
The Information Technology Essentials: PC Hardware
Teacher: & Software course will prepare you to meet the
Teacher: Jaysl requirements of the CompTIA A+ objectives.
pET) @ Internet | Protected Mode: On G mi00% v

To access group tabs you'’ve saved, click the Favorites button,
then click the folder that you want to open. Then click the ar-
row to the right of the folder name. All of the webpages that
were saved will open on separate tabs. Using this method, I|E

groups those tabs by displaying a colour band at the top of
those tabs.

= Keewatin Academy of Information Technology - Windows Internet Explorer

A [C it/ /hcait.ca

File

Edit View BEWLGEN Tools

Help

< Favorites | o= Add to Favorites...
- Add to Favorites Bar -
3 "
Add Current Tabs to Favorites... *§ Google (€ New Tab

] ;ﬁ Keewatir

Organize Favorites...

Favorites Bar
Microsoft Websites
MSN Websites
Windows Live

cisco.com-web-learning-netacad-index.html
Zimbra Collaboration Suite Log In
breeze.edcentre.ca-itel

Connect Pro Meeting Login

KCDC - Employee Communications Metwork
IE8

Keewatin Academy of Information Technology
Internet Explorer cannot display the webpage
Google

New Tab

{EEEm
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Feeds

Feeds are frequently updated content on websites such as blogs
or news websites. They can also be used for sites that often
distribute video, photo or audio content. Audio content offered
in MP3 format is often referred to as podcasting.

Look for a small icon like this: 'b\]'

That is an RSS icon. RSS means “Really Simple Syndication.” It’s
a way for subscribing to, as previously mentioned, frequently
updated content.

To subscribe, all you need to do is click on the icon > a page
listing the number of feeds attached to the RSS will open > click
on the feeds you’d like to subscribe to > a window will pop up.

b = = Z L]
S Favortes | i §§ Keewatin Academy of .. 8] Suggested Sies v 8] Web Sice Galery v ‘ I scn E I ng

8 Circoiog

You are viewing a feed that contain

from the feed is automatically downloaded to your computer and can be viewed in Internet Explorer and

from the feed is automatically downlo

WebEx on LinkedIn: We Need Your Feedback!

e et s P _ .
y— n »—d dbf Subscribe to this feed
[ Subscribe to this Feed o (]

Subscribe to this Feed
@ When you subscribe to a feed, it is automatically added
to the Favorites Center and kept up to date.

== Collaboration

ercdicaly check oinefo updatesto
even when omet Bloer s ot g

Name:
Create in [ Feeds v” New folder ]

' updates to Cisco's Data Center and Virtualization architectures.

|| Add to Favorites Bar

What is 5 Feed? [ Subscribe ] Cancel

*Your computer will periodically check online for updates to
subscribed feeds. even when Intemet Explorer is not running.

environment
Eur

urope
European Markets
facebook

unded ot of the [..]

& powasvosson G,

Type a name for the feed, and if you choose, create a folder for
the feed. |If you want to make the feed easily accessible, click
the “Add to Favorites Bar” checkbox. Then click, the “Subscribe”
button, and you’'re all done!

Congratulations, you'’ve set up your first feed!
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Printing from the Browser
Sometimes you find that you need to print something from your
browser: maybe some text, or maybe an image. First of all, to

print text from a browser

1. Click on File

2. Select Print

3. Select the Printer you wish to print to (if there is more than
one printer available) in the print dialog box.

4. Click on the Print button.
Select Printer
Ppiih; KAITLASER

= Microsoft XPS Document Writer

Select Printer

4 i | v

Status: Ready Print to file

Location:

Commertt Find Prirter...

Page Range

@ Al Number of copies: 1 |5
Selection Current Page

() Pages 1 [ Collste R A .

12|
Enter either a single page number or 3 single ,HL _2,}2' jlr;'J

page range. For example, 5-12

Click the Print Button

Favorites

Favorites are a way of linking to sites you visit often. By
setting a link, you can visit them without having to remember the
URL every time, you can just click on the name of the site in the
Favorites menu. To save a site to your Favorites, follow the

following instructions:
Click on Favorites

1. Click on Favorites.
2. Select Add to Favorites.
3. Click on the Add button.

Add a Favorite

£ Add a Favorite
M Add this webpage as a favorite. To access your favorites, visit the
Favorites Center.
Mame: Keewatin Academy of Information Technolony RN ! &
Create in: [Y;? Favorites V] [ New Folder ]
[ ad ][ Cancel |

E
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Keyboard Shortcuts

Once you get the hang of using the various aspects of |IE, and

mastered all the different options, you probably want an easier

and faster way of accessing them. One method is called
Keyboard Shortcuts. By using specific keystrokes (pressing and
holding two or more keys in combination), you can perform a
task that would normally require a mouse or other pointing
device.

PRESS THIS KEY TO DO THIS
Alt Show the Menu Bar. After you make the selection., the menu bar

goes away.

Alt+Home Go to your Homepage. (i.e. Google, or MSN, etc.)
Alt+C View your favorites, feeds, and browsing history.
Ctrl+L Highlight the text in the Address bar.
Ctrl+D Add a webpage to your favorites.
Ctrl+B Organise your Favorites.

Ctrl+Shift with an arrow key

Shift with any arrow key

Ctrl with any arrow key+Spacebar
Cirl+A

Ctrl+C (or Cirl+Insert)

F4

Esc

Page 13

Select a block of text

Select more than one item in a window or on the desktop, or select

text within a document

Select multiple individual items in a window or on the desktop
Select all items in a document or window

Copy the selected item

Display the address bar list in Windows Explorer

Cancel the current task
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Live Search and Other Search Engines

You can choose which provider you would like to use when you
search for information on the Internet. You can change the search
provider for a specific search (Internet Explorer uses that search
provider until you choose another one or until you close Internet
Explorer) and you can specify which search provider you prefer
to be used by default. When you first install Internet Explorer,
you might have only one provider installed. If you want to
change providers, follow the steps below to add new search
providers.

1. Click the arrow to the right of the search box.
2. Click Find More Providers.
3. Click the search providers you would like to add. This opens the Add Search Provider dialog box.

4. If you want the provider that you just added to be used by default when searching from the Address
bar or search box, select the Make this my default search provider check box.

5. select the Use search suggestions from this provider check box to receive search suggestions.
6. Click Add in Internet Explorer 8, or Add Provider in Internet Explorer 7.

7. Repeat steps 3 through 6 for each provider you want to add.

Click the arrow to the
right of the search box

|2 Keewatin Academy of Information Technology - Winc

e [T

e e |£7] Live Search (Default)

G Keewatin Acsdemy ofIformation Technology

Find on this Page...

Find More Providers...

Manage Search Providers

Keewatin Ac

1 dwatin Academy CISCO ITE,
eomlege training thro ‘
\) and Northern Affairs Canada’s First Nations SchoolNet Youth Program, KAIT a L

provides skills development opportunities for young people at the community
level by preparing them for the CompTIA A+ Certification and Cisco Certified Network Associate Exams,

B Calendar
« March 2011 >

Available Courses

Office 2003/Software Skills Training Sun Mon Tue Wed Thu Fri Sat

= This course covers the Microsoft MOS Objectives in 3B, & %, 1

Teacher: Sharon Angus each of the Office applications. It wil also cover any 6 7 8 8 10 11 12

Teacher: Nick Daigneault additional software as specified. 1314 15 16 17 18 19

(last 5 minutes) 20 2 2 24 25 26
27 28 29 30 3

IT Security
This course compliments the resources that were
distributed with the IT Security Training Package given -
to schools across Saskatchewan. e
There are no upcoming events
Go to calendar
ITE: PC Hardware & Software
The Information Technology Essentials: PC Hardware
Teacher: Nick Daigneault & Software course will prepare you to meet the
Teacher: Jayshree Redwoo requirements of the CompTIA A+ objectives.

@ Intemet | Protected Mode: On
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Deleting Browser History and Internet Cookies

When using Internet Explorer on a public computer, sometimes it
is in your best interests to not share with the next user all the
sites you were just on. For example, if you were checking your
private emails, or checking your bank balance online, you may
not want to share that with everyone who uses IE after you.

An easy, but not foolproof, way of protecting yourself is to
delete your browser history and Internet cookies. This method of
security means you are effectively (but not completely) removing
your tracks from the browser, removing the trail of
“breadcrumbs” you have left behind on your path through the
internet on that particular browser.

To be completely clear, though, no one can completely remove all
their activity from the internet.

This method just makes it more difficult for the average user to
find and abuse your personal information.

To delete the browser history and cookies, follow the steps
below:

1. Click on Tools.

2. Select Delete Browsing History.

3. Check «all applicable boxes: Temporary Internet Files,
Cookies, History, Form Data, Passwords (this one is
especially important if you are on a public computer), and/or
InPrivate Filtering Data.

4. Click the Delete Button.

Usually, it's helpful to have this information stored on your
computer—it can improve your web browsing speed and also
save you from having to type the same information over and
over. But you might want to delete that information if, for
example, you're using a public computer and don't want any of
your personal information to be left behind.

Page 15
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Delete Browsing History

Preserve Favorites website data

Keep cookies and temporary Internet files that enable your favorite
websites to retain preferences and display faster.

Temporary Internet files
Copies of webpages, images, and media that are saved for faster
viewing.

[¥] Cookies
Files stored on your computer by websites to save preferences
such as login information,

History
List of websites you have visited,

7] Form data
Saved information that you have typed into forms.

7] passwords
Saved passwords that are automatically filed in when you sign in
to & website you've previously visited,

|| InPrivate Filtering data

Saved data used by InPrivate Filtering to detect where websites may
be automatically sharing details about your visit,

About deleting browsing history Delete ] [ Cancel ]

InPrivate Filtering provides a way for you to see which third-
party websites are receiving your browsing information, and lets
you choose which to allow and which to block. InPrivate Filtering
is applied per-session—you have to turn it on every ftime you
open your browser.

When you block content on a website, you could get either a
poor experience with missing elements, or the site might not work
at all. That can happen when website contains a web analysis
tool that isn't a visually obvious to you, but is financially
necessary to the website. If you want to block the content that
helps the website pay the bills, the site might not want you to be
there.

When InPrivate Filtering is turned off, the status bar icon is

i) d)
gray ’ﬂ, and is in color Twhen InPrivate Filtering is on. Click
the icon, or press Ctrl+Shift+F once, and InPrivate Filter is on.

Do it again, and InPrivate Filtering is off.
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In Closing ...

So now you should be a bit more familiar with your Internet
Explorer. Hopefully, with time, and this newfound familiarity,
you will be comfortable enough to use IE to not only explore the
World Wide Web, but explore it with a newfound enthusiasm!

Should you find yourself in a really tough spot, don’t forget
there’s always the F1 key (aka HELPI!)! ;)

N’




